EXCEL 2000 Project One Review

True/False

_____ Web support allows Excel to save workbooks or parts of a workbook in HTML format so they can be viewed and manipulated using a browser.

_____ Inside an Excel workbook are sheets, called booksheets.

_____ A new Excel workbook opens with three worksheets, but, if necessary, additional worksheets can be added to a maximum of 255.

_____ A cell is referred to by its unique address, or cell reference, which is the coordinates of the intersection of a column and a row.

_____ The menu bar, Standard toolbar, and Formatting toolbar display at the bottom of the screen just above the status bar.

_____ When a menu name on the menu bar is clicked, a short menu displays listing the most recently used commands.

_____ If the arrows at the bottom of a short menu are clicked, a full menu displays that lists all the commands associated with a menu.

_____ A hidden command displays in a faint type, which indicates it is not available for the current selection.

_____ A dimmed command does not display on the short menu.

_____ As data is typed, the data displays in the Name box, and Excel displays the active cell reference in the formula bar.

_____ Mode indicators, such as NUM (Num Lock), CAPS (Caps Lock), and SCRL (Scroll) show which keys are engaged.

_____ When the mode indicator reads Ready, Excel is ready to accept the next command or data entry.

_____ When the mode indicator reads Enter, Excel is in the process of accepting data through the keyboard into the active cell.

_____ Keyboard indicators, such as Enter and Ready, display on the status bar and specify the current mode.

_____ In Excel, any set of characters containing a letter, hyphen (as in a telephone number), or space is considered text.

_____ The insertion point is a blinking vertical line that indicates where the next character typed will display.

_____ Clicking the Enter box completes an entry, and clicking the Cancel box cancels the entry.

_____ When the text entered is longer than the width of a column, Excel displays the overflow characters in adjacent cells to the left as long as these adjacent cells contain data.

_____ When an arrow key is pressed to complete an entry in a cell, the adjacent cell in the direction of the arrow (up, down, left, or right) becomes the active cell.

_____ Numbers can contain only the following characters: 0 1 2 3 4 5 6 7 8 9 + - ( ) , / . $ % E e.

_____ Numbers entered into a worksheet are right-aligned, which means Excel displays the cell entry to the far right in the cell.

_____ When proposing a range of cells to sum, Excel first looks for a range of cells with numbers below the active cell and then to the right.

_____ The range of cells receiving a copy is called the copy area.

_____ The cell being copied is called the paste area.

_____ If each cell in a selected range is next to a row of numbers, Excel assigns the SUM function to each cell in the selected range when the AutoSum button is clicked.

_____ A worksheet is formatted to emphasize entries and make the worksheet easier to read and understand.

_____ The font type indicates how characters are formatted, such as regular, underlined, or italicized.

_____ A character with a point size of 10 is about 10/72 of one inch in height.

_____ Font style defines the appearance and shape of letters, numbers, and special characters.

_____ When Excel begins, the preset font type for the entire workbook is Arial with a size and style of 10-point regular.

_____ You bold an entry in a cell to camouflage it or make it blend into the rest of the worksheet.

_____ When the Merge and Center button is clicked to center a worksheet title across the range A1:F1, Excel not only centers the title but also merges cells A1 through F1 into one cell, cell A1.

_____ Most formats assigned to a cell will display on the Standard toolbar when the cell is selected.

_____ Excel derives the scale along the vertical axis (also called the y-axis or value axis) of a Column chart on the basis of the values in the worksheet.

_____ Excel automatically selects the entries in the topmost row of a selected range as the titles for the horizontal axis (x-axis or category axis) of a Column chart and draws a column for each cell in the range containing numbers.

_____ When Excel is installed on a computer, the default chart type, or the type of chart Excel draws if the Finish button is clicked in the first Chart Wizard dialog box, is the 3-D (three-dimensional) Pie chart.

_____ If the computer is turned off or if power is lost while building a workbook, the computer stores the workbook in memory.

_____ In the list box that displays when the Tools button is clicked in the Save As dialog box, the General Options command allows a backup copy of the workbook to be saved, a password to be created to limit access to the workbook, and other functions to be carried out.

_____ Saving a backup workbook means that each time the workbook is saved, Excel copies the current version of the workbook on disk to a file with the same name, but with the words, Backup of, appended to the front of the file name.

_____ Case sensitive means that Excel cannot differentiate between uppercase and lowercase letters.

_____ If a print area is not selected, Excel automatically selects a print area on the basis of used cells.

_____ The Close button and Control-menu icon on the title bar close the workbook, and the Close button and Control-menu icon on the menu bar close Excel.

_____ If the entry in a cell is long and the errors are minor, Edit mode may be a better choice than selecting the cell and retyping the entire entry.

_____ To delete a character in a cell, move the insertion point to the right of the character to be deleted and then press the DELETE key, or place the insertion point to the left of the character to be deleted and then press the BACKSPACE key.

_____ In Insert mode, Excel overtypes the character to the right of the insertion point.

_____ In Overtype mode, as a character is typed, Excel inserts that character and moves all characters to the right of the typed character one position to the right.

_____ Excel provides the Undo command on the Edit menu and the Undo button on the Standard toolbar to repeat previous actions.

_____ The Redo button on the Standard toolbar and the Redo command on the Edit menu can be used to erase the most recent cell entry.

_____ Always press the SPACEBAR to clear a cell.

_____ With the Office Assistant active, a question, word, or phrase can be typed in a text box and the Office Assistant provides immediate help on the subject.

Fill in the appropriate answer.

__________ is a powerful spreadsheet program that allows users to organize data, complete calculations, make decisions, graph data, develop professional looking reports, publish organized data to the Web, and access real-time data from Web sites.

To the right of the sheet tabs at the bottom of the screen is the __________, which can be dragged to increase or decrease the view of the sheet tabs.

The menu bar that displays when Excel is started is the __________.

When working with a chart sheet rather than a worksheet, the __________ displays with names that reflect charting commands.

When the mouse pointer is moved over a toolbar button or box, the name of the button or box displays below it in a(n) __________.

The easiest way to __________ (make it active) is to use the mouse to move the block plus sign to the cell and then click.

The __________ is an Excel feature that works behind the scenes, correcting common mistakes when a text entry is completed in a cell.

The __________ on the Standard toolbar can be used to enter the SUM function.

A(n) __________ is a series of two or more adjacent cells in a column or row or a rectangular group of cells.

When cell references are copied and adjusted for each new position, each adjusted cell reference is called a(n) __________.
 
The __________ is the small black square located in the lower-right corner of the heavy border around the active cell.

The heavy border and transparent (blue) background indicating a selected range is called __________.

The __________ specifies the size of the characters on the screen.

Excel has several customized format styles called __________.

The __________ on the Format menu can be used to format the body of a worksheet automatically.

A 3-D Column chart drawn on the same worksheet as the data is called a(n) __________.

With the range to chart selected, the __________ on the Standard toolbar is clicked to initiate drawing the chart.

The area on a worksheet where a chart displays is called the __________.

A saved workbook is referred to as a(n) __________.

The General Options command in the Tools list can be used to assign a(n) __________ to a workbook so others cannot open it.

A printed version of a worksheet is called a(n) __________.

When columns and rows in a worksheet are selected prior to clicking the Print button, the range of cells chosen to print is called the __________.

An editing procedure called __________ is used to edit the contents directly in a cell.

The __________ next to the column headings can be used to select the entire worksheet.

At any time while using Excel, answers to questions can be obtained by using the __________.

The __________ answers questions and suggests more efficient ways to complete a task.

The Office Assistant tip feature is part of the __________ that is built into Excel, which understands what a user is trying to do and suggests better ways to do it. 

__________, a primary part of Excel, pictorially represent(s) data.

A __________, which is the intersection of a column and row, is the basic unit of a worksheet into which data is entered.

The active cell can be identified in all of the following ways except __________.

The mouse pointer turns into the __________ whenever it is moved outside the worksheet or when cell contents are dragged between rows or columns.

Below and to the right of a worksheet are __________ that can be used to move the window around to view different parts of the active worksheet.

An alternative to sliding one toolbar over another is to use the __________ on a toolbar to display the buttons that are hidden.

The status bar displays __________.

An alternative method to using the mouse to select a cell is to use the __________ located just to the right of the typewriter keys on the keyboard.

Excel positions text __________ the cell.

If a wrong letter is typed and the error is noticed before clicking the Enter box, use the __________ to erase all the characters back to and including the one that is wrong.

Excel’s AutoCorrect feature makes all the following corrections except __________.

Excel’s __________ provides a convenient means to add the numbers in a range of cells.

A range can be entered by typing the beginning cell reference, a __________, and the ending cell reference.

Font size is measured in points; a single point is about __________ of one inch in height.

To select any cell, click the __________ located on the left side of the formula bar and enter the cell reference of the desired cell.

The small __________ at the corners and sides along the selection rectangle indicate a chart is selected.

The __________ identifies each bar in a chart.

When a file is saved, Excel automatically appends the extension __________ to the entered file name, which stands for Excel workbook.

The __________, on the left of the Save As dialog box, displays a list of shortcuts (pointers) to the most recently used files in a folder titled Recent.

A total, an average, or other information about numbers in a range easily can be obtained by using the __________ on the status bar.

The __________ not only deletes the contents from a range, but also copies the range to the Office Clipboard.

An unsaved workbook can be cleared by clicking the workbook’s Close button or by clicking Close on the __________ menu.

